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RELEASE NOTES

NI-IMAQ FOR WINDOWS NT/98/95
NI-IMAQ for Windows NT/98/95 is the image acquisition software for 
all National Instruments IMAQ devices.

These release notes describe how to install your NI-IMAQ software. 
Also included is information about upgrading from NI-IMAQ 1.x to 
NI-IMAQ 2.2. Please also see the readme.txt  file included with your 
software for the most up-to-date information about this release of 
NI-IMAQ.
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What’s New in NI-IMAQ 2.2
This release of NI-IMAQ includes several major revisions, as follows:

• Replaces the IMAQ Configuration Utility with the new 
Measurement & Automation Explorer. For more information on 
the Measurement & Automation Explorer, see the IMAQ Hardware 
Configuration section in this document or go to the Measurement & 
Automation Explorer online help (Help»Help Topics).

• Supports the new IMAQ PCI-1411 image acquisition device, which 
supports color analog cameras.
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NI-IMAQ Documentation
Your NI-IMAQ software documentation is online. Refer to the About the 
Online Manual Set section later in these notes for more information about 
using the online manuals.

Software Components
Your NI-IMAQ software kit contains the following components:

❑ NI-IMAQ device driver software

❑ NI-IMAQ Microsoft Visual C/C++, Borland, and CodeWarrior import 
libraries

❑ ComponentWorks IMAQ Acquisition Control for Active X support

❑ NI-IMAQ VIs for G

❑ Measurement & Automation Explorer for IMAQ

❑ NI-IMAQ for Windows NT/98/95 installer

❑ NI-IMAQ sample code

❑ Online documentation
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Installation Procedures
Insert the NI-IMAQ CD into your drive. An autorun screen appears, as 
shown in Figure 1.

Click on Install NI-IMAQ  to launch the NI-IMAQ 2.2 installer and follow 
the instructions on the installation screens. You must install NI-IMAQ 
before installing your IMAQ hardware device.

Note You must have administrator access in Windows NT to perform the installation.

Figure 1.  Initial Installer Screen

The Install IMAQ Vision Evaluation option allows you to install 
evaluation versions of IMAQ Vision for LabVIEW, BridgeVIEW, 
LabWindows/CVI, and ComponentWorks. IMAQ Vision adds high-level 
machine vision and image processing functions to your application 
development environment.

The View Release Notes and View Online Documents options allow you 
to view the online documentation for NI-IMAQ 2.2 and your IMAQ device. 
These documents are provided in Adobe Acrobat portable document 
format (pdf). If you do not have Acrobat Reader installed on your system, 
you will be prompted to install it using the installer provided on the CD.
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IMAQ Hardware Configuration
NI-IMAQ 2.2 introduces the Measurement & Automation Explorer, the 
new National Instruments utility for configuring your measurement and 
automation system.

An icon for Measurement & Automation Explorer, which replaces the 
IMAQ Configuration Utility from earlier versions of NI-IMAQ, appears on 
your desktop after you install NI-IMAQ 2.2. Double-click this icon to run 
the utility. You can also configure other National Instruments hardware, 
such as DAQ or GPIB devices, from the Measurement & Automation 
Explorer.

The Measurement & Automation Explorer interface is similar to the IMAQ 
Configuration Utility; however, there are some changes. Instructions on 
configuring an IMAQ device are included in the Measurement & 
Automation online help. You can access the online help through the Help 
menu in Measurement & Automation Explorer.

Configure and test your IMAQ hardware by running the Measurement & 
Automation Explorer. Refer to the Getting Started with Your IMAQ System 
document for your device and the Measurement & Automation Explorer 
online help for configuration, installation, and testing instructions.

Two other new features in the Measurement & Automation Explorer 
include image zooming and drag and drop image saving.

To zoom in or out of your images, right-click on the image and choose 
Zoom in or Zoom out to zoom in incremental steps or Zoom to select the 
ratio. You can use the zoom feature after a snap or while grabbing images.

To quickly save your current image to your desktop as a bitmap, click in the 
image window with your left mouse button and drag the image to your 
desktop. A new bitmap image file then appears on your desktop. You can 
open this bitmap file in any program that supports the standard bitmap file 
format. This technique saves the current still image, whether it was taken 
with a snap or a grab; it will not save images from a currently running grab.
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NI-IMAQ 2.1 Changes for LabVIEW 5.1 
NI-IMAQ 2.1 changes for LabVIEW 5.1 include a new IMAQ Property 
Node and a new IMAQ Session control.

IMAQ Property Node
In LabVIEW 5.1, the IMAQ property node replaces the NI-IMAQ 
Attribute VI and incorporates all attributes used with it. If you are using 
LabVIEW 5.0 or earlier, continue using the IMAQ Attribute VI to set 
IMAQ attributes.

The IMAQ Property Node gets and/or sets IMAQ properties. The node is 
growable; evaluation starts from the top and proceeds downward until an 
error or the final evaluation occurs. To access the property node, select 
Functions»Image Acquisition and select the Property Node icon located 
on the bottom row of the Image Acquisition palette. For more information 
on the IMAQ Property Node, see the NI-IMAQ VI Reference Manual.

IMAQ Session Control
In LabVIEW 5.1, the IMAQ Refnum control has been replaced 
with the IMAQ Session control. The control is located on the 
Controls»Path&Refnum palette. If you used an integer to represent 
the IMAQ Refnum control in the past, you may need to replace those 
integers with IMAQ Session controls.
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Additional Color Attributes
Additional color attributes have been added to NI-IMAQ 2.2 functions and 
VIs. These attributes are not included in the online documentation.

Table 1 shows a list of additional attributes for NI-IMAQ functions. Use 
these attributes with the imgSetAttribute  and imgGetAttribute  
functions.

Attribute describes the constant name of the attribute. The type is the 
attribute’s data type. I/S describes whether the get/set attribute function 
requires an INTERFACE_ID (I) or SESSION_ID (S) type parameter. Imd. 
describes whether the effect of setting the attribute is immediate (Yes), or 
whether it requires a subsequent imgSessionConfigure  to take effect 
(No). R/W describes whether the attribute is read only (R), write only (W), 
or both (R/W). Description describes what values the attribute can take and 
the effect the setting of the attribute has or what values are returned.

Table 1.  Attribute Summary

Attribute Type I/S Imd. R/W Description

IMG_ATTR_GAIN_BLUE double* S No R/W Gets/sets the gain applied to 
the blue color plane of the 
RGB image. This gain also 
affects the blue data used to 
calculate the hue, saturation, 
and luminance planes. The 
range is 0.8 to 1.2. Default 
value is 1.0.

IMG_ATTR_GAIN_GREEN double* S No R/W Gets/sets the gain applied to 
the green color plane of the 
RGB image. This gain also 
affects the green data used to 
calculate the hue, saturation, 
and luminance planes. The 
range is 0.8 to 1.2. Default 
value is 1.0.

IMG_ATTR_GAIN_RED double* S No R/W Gets/sets the gain applied to 
the red color plane of the RGB 
image. This gain also affects 
the red data used to calculate 
the hue, saturation, and 
luminance planes. The range 
is 0.8 to 1.2. Default value 
is 1.0.



© National Instruments Corporation 7 NI-IMAQ for Windows NT/98/95 Release Notes

If you use NI-IMAQ VIs to program your IMAQ device, use the following 
properties with the IMAQ Property Node to get or set color properties:

Color Gain Blue

Gets/sets the gain applied to the blue color plane of the RGB image. This 
gain also affects the blue data used to calculate the hue, saturation, and 
luminance planes. The range is 0.8 to 1.2. Default value is 1.0.

Access Privilege: Read/Write

Color Gain Green

Gets/sets the gain applied to the green color plane of the RGB image. This 
gain also affects the green data used to calculate the hue, saturation, and 
luminance planes. The range is 0.8 to 1.2. Default value is 1.0.

Access Privilege: Read/Write

Color Gain Red

Gets/sets the gain applied to the red color plane of the RGB image. This 
gain also affects the blue data used to calculate the hue, saturation, and 
luminance planes. The range is 0.8 to 1.2. Default value is 1.0.

Access Privilege: Read/Write

LabVIEW/BridgeVIEW Compatibility 
between NI-IMAQ 1.x and 2.x

The NI-IMAQ VIs changed between NI-IMAQ 1.5 and 2.x to increase ease 
of use and to add more functionality. The following changes were made:

• All VIs now have a IMAQ Session In and IMAQ Session Out 
parameter. This is similar to the TaskID input/output used with the 
data acquisition VIs.

• The underscore has been removed from all VI names.

• Low-level acquisition VIs have been added. These VIs add more 
functionality such as asynchronous acquisitions, accessing buffers 
during acquisition, ring acquisitions, and the ability to download 
custom look-up tables (LUTs) to your IMAQ device.

• Signal I/O VIs have been added. These VIs allow you to control trigger 
lines, generate specific timing pulses, and wait for a hardware event.
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High-Level VI Changes
IMAQ_Grab is now two VIs—IMAQ Grab Setup and IMAQ Grab 
Acquire. IMAQ Grab Setup starts the grab acquisition. IMAQ Grab 
Acquire returns a copy of the image currently in the buffer. You can use 
IMAQ Close to stop the hardware acquisition.

IMAQ Sequence no longer has a mode input, which required that you call 
the VI four times to perform a sequence acquisition. Instead, call IMAQ 
Sequence once to set up the acquisition, perform the acquisition, and return 
the acquired images.

IMAQ_1408 Setup Analog has been removed. IMAQ_1408 Setup Analog 
allowed the white and black reference levels to be set in volts. Use the 
IMAQ Attribute VI to achieve the same functionality. The White 
Reference Level and Black Reference Level attributes in NI-IMAQ 2.2 
are now set in volts instead of steps.

IMAQ_Snap Async has been removed because the functionality is now 
provided in IMAQ Snap. IMAQ Snap is now asynchronous so that you can 
use it with triggering.

IMAQ_Wait for Event has been changed to IMAQ Wait Signal. The IMAQ 
Wait Signal VI has the same functionality as IMAQ_Wait for Event with 
additions for the IMAQ PCI-1424.

IMAQ_Trigger Control has been replaced by three VIs. IMAQ Trigger 
Configure configures trigger lines to allow an acquisition to start on a 
trigger. IMAQ Trigger Drive drives a trigger line with a specified signal. 
IMAQ Trigger Read reads the current value of a trigger line.

IMAQ_Trigger RTSI Map has been removed. The mapping of RTSI lines 
is now handled internally by NI-IMAQ. If you specify a RTSI line when 
using the trigger VIs, NI-IMAQ internally maps the RTSI line on the RTSI 
bus to a RTSI trigger line on the IMAQ board.

IMAQ_Info has been removed. The same functionality is available with 
IMAQ Attribute.

IMAQ_Channel has been removed. The acquisition VIs now have a 
channel input that allows you to select a channel on the IMAQ board.
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Compatibility VIs
All of the NI-IMAQ 1.5 VIs are available as compatibility VIs. They are 
installed in the vi.lib/addons/imaq/compatibility  directory; 
however, they do not appear on the imaqview palette. These VIs allow you 
to load and run existing IMAQ applications without changing your code. 
You should replace your NI-IMAQ 1.5 VIs with NI-IMAQ 2.2 VIs at your 
earliest convenience, because the compatibility VIs will not be included in 
future NI-IMAQ releases.

NI-IMAQ provides a tool that will convert some of the NI-IMAQ 1.x VIs 
to 2.2 VIs. Using this tool, you can convert the following VIs:

• IMAQ_Snap to IMAQ Snap

• IMAQ_Snap Async to IMAQ Snap

• IMAQ_Init to IMAQ Init

• IMAQ_Close to IMAQ Close

• IMAQ_Attribute to IMAQ Attribute

• IMAQ_StillColor Attribute to IMAQ StillColor Attribute

• IMAQ_StillColor Setup to IMAQ StillColor Setup

To use the conversion tool, launch lvimaq.exe , which is located in the 
<ni-imaq>/G compatibility  directory. This will launch a special 
version of LabVIEW that contains the conversion tool. Load your IMAQ 
application. As your application loads, the appropriate NI-IMAQ VIs will 
be converted. After your VI loads, save it. You can now load the VI into 
LabVIEW or BridgeVIEW and convert the VIs that were not converted.

Note This conversion tool will only work with LabVIEW 5.x or BridgeVIEW 2.x VIs. If 
you have an earlier version of LabVIEW or BridgeVIEW, do not use this tool.
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The following table describes the corresponding NI-IMAQ 2.2 VI for each 
NI-IMAQ 1.x VI.

Table 2.  NI-IMAQ VI Equivalents

NI-IMAQ 1. x VI NI-IMAQ 2.2

IMAQ_Snap IMAQ Snap

IMAQ_Grab IMAQ Grab Setup, IMAQ Grab 
Acquire

IMAQ_Sequence IMAQ Sequence

IMAQ_Init IMAQ Init

IMAQ_Close IMAQ Close

IMAQ_Attribute IMAQ Attribute

IMAQ_1408 Setup Analog Removed (same functionality is 
available with IMAQ Attribute)

IMAQ_Snap Async Removed (IMAQ Snap provides 
the same functionality)

IMAQ_Wait for event IMAQ Wait Signal

IMAQ_Trigger Control IMAQ Trigger Configure replaces 
starting an acquisition on a trigger

IMAQ Trigger Drive replaces 
driving trigger lines

IMAQ Trigger Read replaces 
reading trigger lines

IMAQ_Trigger RTSI Map Removed (VIs will perform this 
functionality internally)

IMAQ_Info Removed (same functionality is 
available with IMAQ Attribute)

IMAQ_Channel Removed (acquisition VIs now 
have channel input)
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NI-IMAQ 1.x and 2.x Compatibility
The following changes have been made to NI-IMAQ between versions 1.x 
and 2.x:

• Functions

– imgSessionSetTrigger  has been replaced 
with imgSessionTriggerConfigure  
andimgSessionTriggerDrive.  
imgSessionTriggerConfigure  configures a trigger to start an 
acquisition. ImgSessionTriggerDrive  drives a trigger with a 
specified signal. ImgSessionSetTrigger  is still supported; 
however, you should use the new trigger functions.

– imgSessionSaveBuffer  has been replaced with 
imgSessionSaveBufferEx , which takes a buffer pointer 
instead of a buffer number to determine which buffer to save 
to file.

– New LUT functions, imgSessionSetUserLUT8bits  and 
imgSessionSetUserLUT16bits , allow you to download 
custom LUTs to your IMAQ device.

– The imgSessionReleaseBuffer  parameter list changed.

• Camera attributes

– The camera attributes allow you to control camera functions, such 
as integration time and pixel binning, directly from NI-IMAQ 
with the IMAQ PCI-1424. Consult the Camera Attributes section 
in the NI-IMAQ User Manual for more information.

• Attributes

– IMG_ATTR _WHITE_REF, IMG_ATTR _BLACK_REF, and 
IMG_ATTR_GAIN have been replaced by 
IMG_ATTR_BLACK_REF_VOLT and 
IMG_ATTR_WHITE_REF_VOLT. This allows you to set the 
black and white reference in volts instead of steps.

– IMG_ATTR_LUT is now a session attribute instead of an 
interface attribute.

– IMG_ATTR_FRAME_FIELD is now a session attribute instead 
of an interface attribute.

– IMG_ATTR_INTERFACE_TYPE has been removed.



About the Online Manual Set
The IMAQ hardware and software documentation set ships with your 
software as Adobe Acrobat portable document format (PDF) files. 

To view one of these documents, double-click on the DocList.pdf  file, 
located in the Documents  folder on your NI-IMAQ CD. Click on any 
document name to launch the document you want to view.

Note If you do not already have Acrobat Reader installed on your system, the installer will 
create a new directory, <target install dir>\ACROREAD , and insert the Adobe 
Acrobat Installer into it. Run this installer before viewing your online documentation. You 
must have Acrobat Reader 3.0 or later installed to use the online documentation.

Using the NI-IMAQ Online Manual Set
The NI-IMAQ software online help and PDF documentation also is 
installed onto your hard drive with the NI-IMAQ software.

To view the online help, click the Start button on the taskbar, point to 
Start»Programs»National Instruments IMAQ and choose either 
NI-IMAQ Function Help  or NI-IMAQ VI Help .

To view the PDF documents, click the Start button on the taskbar, point to 
Start»Programs»National Instruments IMAQ»Documentation, and 
choose the appropriate document. This will automatically launch the 
Acrobat Reader and open the selected PDF file. You can assemble your 
own printed manuals by printing either the entire documentation set or only 
the sections relevant to your application.

Click on any entry in the table of contents to jump directly to that page. 
Jump to major sections within the document by clicking on the bookmarks.

When you choose the View»Go To Page... option or are printing pages, 
you must use the page numbers in the lower left corner of the Acrobat 
window, not the number displayed at the bottom center of each manual 
page or listed in the contents and index. The PDF files are electronic 
equivalents of printed manuals. However, unlike printed manuals, the PDF 
file assigns consecutive numbers to each page throughout the document and 
displays this page number. These numbers may not match those shown at 
the bottom center of each manual page.

To quickly find every occurrence of any word or phrase, select the 
Tools»Find... option and type in the key word or phrase you want to find.
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